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6-PIN DIP RANDOM-PHASE
OPTOISOLATORS TRIAC DRIVER OUTPUT

(250/400 VOLT PEAK)

 

MOC3010M MOC3011M MOC3012M MOC3020M MOC3021M MOC3022M MOC3023M

DESCRIPTION

 

The MOC301XM and MOC302XM series are optically isolated triac driver devices. These devices contain a GaAs infrared 
emitting diode and a light activated silicon bilateral switch, which functions like a triac. They are designed for interfacing between 
electronic controls and power triacs to control resistive and inductive loads for 115 VAC operations.

 

FEATURES

 

• Excellent I

 

FT

 

 stability—IR emitting diode has low degradation
• High isolation voltage—minimum 5300 VAC RMS
• Underwriters Laboratory (UL) recognized—File #E90700
• Peak blocking voltage

– 250V-MOC301XM
– 400V-MOC302XM

• VDE recognized (File #94766)
– Ordering option V (e.g. MOC3023VM)

 

APPLICATIONS 

 

• Industrial controls • Solenoid/valve controls
• Traffic lights • Static AC power switch
• Vending machines • Incandescent lamp dimmers
• Solid state relay • Motor control
• Lamp ballasts
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Note

 

1. Isolation surge voltage, V

 

ISO

 

, is an internal device dielectric breakdown rating.  For this test, Pins 1 and 2 are common, and 
Pins 4, 5 and 6 are common.

 

ABSOLUTE MAXIMUM RATINGS

 

 (T

 

A

 

 = 25°C unless otherwise noted)

 

Parameters Symbol Device Value Units

TOTAL DEVICE

 

Storage Temperature T

 

STG

 

All -40 to +150 °C

Operating Temperature T

 

OPR

 

All -40 to +85 °C

Lead Solder Temperature T

 

SOL

 

All 260 for 10 sec °C

Junction Temperature Range T

 

J

 

All -40 to +100 °C

Isolation Surge Voltage

 

(1)

 

 
(peak AC voltage, 60Hz, 1 sec duration)

V

 

ISO

 

All 7500 Vac(pk)

Total Device Power Dissipation @ 25°C
P

 

D

 

All
330 mW

Derate above 25°C 4.4 mW/°C

 

EMITTER

 

Continuous Forward Current I

 

F

 

All 60 mA

Reverse Voltage V

 

R

 

All 3 V

Total Power Dissipation 25°C Ambient
P

 

D

 

All
100 mW

Derate above 25°C 1.33 mW/°C

 

DETECTOR

 

Off-State Output Terminal Voltage V

 

DRM

 

MOC3010M/1M/2M
MOC3020M/1M/2M/3M

250
400

V

Peak Repetitive Surge Current (PW = 1 ms, 120 pps) I

 

TSM

 

All 1 A

Total Power Dissipation @ 25°C Ambient
P

 

D

 

All
300 mW

Derate above 25°C 4 mW/°C



 

4/30/03

 

Page 3 of 10

 

© 2003 Fairchild Semiconductor Corporation

 

6-PIN DIP RANDOM-PHASE
OPTOISOLATORS TRIAC DRIVER OUTPUT

(250/400 VOLT PEAK)

 

MOC3010M MOC3011M MOC3012M MOC3020M MOC3021M MOC3022M MOC3023M

 

 

 

Note

 

1. Test voltage must be applied within dv/dt rating.

2. This is static dv/dt. See Figure 5 for test circuit. Commutating dv/dt is a function of the load-driving thyristor(s) only.

3. All devices are guaranteed to trigger at an I

 

F

 

 value less than or equal to max I

 

FT

 

. Therefore, recommended operating I

 

F

 

 lies 
between max I

 

FT

 

 (30 mA for MOC3020M, 15 mA for MOC3010M and MOC3021M, 10 mA for MOC3011M and MOC3022M, 
5 mA for MOC3012M and MOC3023M) and absolute max I

 

F

 

 (60 mA).

 

ELECTRICAL CHARACTERISTICS 

 

(T

 

A

 

 = 25°C Unless otherwise specified)

 

INDIVIDUAL COMPONENT CHARACTERISTICS

 

Parameters Test Conditions Symbol Device Min Typ Max Units

EMITTER 

 

Input Forward Voltage I

 

F

 

 = 10 mA V

 

F

 

All 1.15 1.5 V

Reverse Leakage Current V

 

R

 

 = 3 V, T

 

A

 

 = 25°C I

 

R

 

All 0.01 100 µA

 

DETECTOR

 

Peak Blocking Current,Either Direction  Rated V

 

DRM

 

, I

 

F

 

 = 0 (note 1) I

 

DRM

 

All 10 100 nA

Peak On-State Voltage,Either Direction I

 

TM

 

 = 100 mA peak, I

 

F

 

 = 0 V

 

TM

 

All 1.8 3 V

 

TRANSFER CHARACTERISTICS

 

  (T

 

A

 

 = 25°C Unless otherwise specified.)

 

DC Characteristics Test Conditions Symbol Device Min Typ Max Units

 

LED Trigger Current Voltage = 3V (note 3) I

 

FT

 

MOC3020M 30

mA

MOC3010M
15

MOC3021M

MOC3011M
10

MOC3022M

MOC3012M
5

MOC3023M

Holding Current, Either Direction I

 

H

 

All 100 µA
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Fig. 1 LED Forward Voltage vs. Forward Current

Fig. 3 Trigger Current vs. Ambient Temperature
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Fig. 4 LED Current Required to Trigger vs. LED Pulse Width

Fig. 6 Leakage Current, IDRM vs. Temperature

Fig. 2 On-State Characteristics
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1. The mercury wetted relay provides a high speed repeated 
pulse to the D.U.T.

2. 100x scope probes are used, to allow high speeds and 
voltages.

3. The worst-case condition for static dv/dt is established by 
triggering the D.U.T. with a normal LED input current, then 
removing the current. The variable R

 

TEST

 

 allows the dv/dt 
to be gradually increased until the D.U.T. continues to 
trigger in response to the applied voltage pulse, even 
after the LED current has been removed. The dv/dt is 
then decreased until the D.U.T. stops triggering. 

 

τ

 

RC

 

 is 
measured at this point and recorded.

Note: This optoisolator should not be used to drive a load directly. 
It is intended to be a trigger device only.

Vdc

400V (MOC302X)
250V (MOC301X)

R = 10 kΩ

CTEST

X100
SCOPE
PROBE

PULSE
INPUT MERCURY

WETTED
RELAY

RTEST

D.U.T.D.U.T.

Figure 5. Static dv/dt Test Circuit

252 V (MOC302X)
158 V (MOC301X)

0 VOLTS

APPLIED VOLTAGE
WAVEFORM

Vmax =

dv/dt =  
0.63 Vmax  =   

252

τRC

τRC τRC

   400 V (MOC302X)
= 250 V (MOC301X)

(MOC302X)

=   
158
τRC

(MOC301X)

Figure 6. Resistive Load

Figure 7. Inductive Load with Sensitive Gate Triac (IGT ≤ 15 mA)
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Figure 9. Typical Application Circuit
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LOAD

360

39

470

240
VAC

HOT

GROUND

MOC3020M
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Figure 8. Inductive Load with Sensitive Gate Triac (IGT ≤ 15 mA)

Rin
VCC
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180

C1

1.2 k

ZL

120 V
60 HzMOC3010M

MOC3011M
MOC3012M

In this circuit the “hot” side of the line is switched and the load connected to the cold or ground side.

The 39 ohm resistor and 0.01µF capacitor are for snubbing of the triac, and the 470 ohm resistor and 
0.05 µF capacitor are for snubbing the coupler. These components may or may not be necessary 
depending upon the particular and load used.
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NOTE

 

All dimensions are in inches (millimeters)

Package Dimensions (Through Hole) Package Dimensions (Surface Mount)

Package Dimensions (0.4” Lead Spacing) Recommended Pad Layout for
Surface Mount Leadform

0.350 (8.89)
0.320 (8.13)

0.260 (6.60)
0.240 (6.10)

0.320 (8.13)

0.070 (1.77)
0.040 (1.02)

0.014 (0.36)
0.010 (0.25)

0.200 (5.08)
0.115 (2.93)

0.100 (2.54)
0.015 (0.38)

0.020 (0.50)
0.016 (0.41) 0.100 (2.54)

15°

0.012 (0.30)

0.350 (8.89)
0.320 (8.13)

0.260 (6.60)
0.240 (6.10)

0.390 (9.90)
0.332 (8.43)

0.070 (1.77)
0.040 (1.02)

0.014 (0.36)
0.010 (0.25)

0.320 (8.13)

0.035 (0.88)
0.006 (0.16)

0.012 (0.30)
0.008 (0.20)

0.200 (5.08)
0.115 (2.93)

0.025 (0.63)
0.020 (0.51)

0.020 (0.50)
0.016 (0.41)

0.100 [2.54]

0.350 (8.89)
0.320 (8.13)

0.260 (6.60)
0.240 (6.10)

0.070 (1.77)
0.040 (1.02)

0.014 (0.36)
0.010 (0.25)

0.200 (5.08)
0.115 (2.93)

0.020 (0.50)
0.016 (0.41)

0.100 [2.54]

0.100 (2.54)
0.015 (0.38)

0.012 (0.30)
0.008 (0.21)

0.425 (10.80)
0.400 (10.16)

0.070 (1.78)

0.060 (1.52)

0.030 (0.76)

0.100 (2.54)

0.305 (7.75)

0.425 (10.79)
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ORDERING INFORMATION

MARKING INFORMATION

 

Option Order Entry Identifier Description

 

S S Surface Mount Lead Bend

SR2  SR2 Surface Mount; Tape and reel

T T 0.4" Lead Spacing

V V VDE 0884

TV TV VDE 0884, 0.4" Lead Spacing

SV SV VDE 0884, Surface Mount

SR2V SR2V VDE 0884, Surface Mount, Tape & Reel

MOC3010

V    X   YY   Q

1

2

6

43 5

*Note – Parts that do not have the ‘V’ option (see definition 3 above) that are marked with 
date code ‘325’ or earlier are marked in portrait format.

Definitions

1 Fairchild logo

2 Device number

3
VDE mark (Note: Only appears on parts ordered with VDE 
option – See order entry table)

4 One digit year code, e.g., ‘3’

5 Two digit work week ranging from ‘01’ to ‘53’

6 Assembly package code
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NOTE

 

All dimensions are in inches (millimeters)

 

Reflow Profile (White Package, -M Suffix)

Carrier Tape Specifications

4.0 ± 0.1

Ø1.5 MIN

User Direction of Feed

2.0 ± 0.05

1.75 ± 0.10

11.5 ± 1.0

24.0 ± 0.3

12.0 ± 0.1

0.30 ± 0.05

21.0 ± 0.1

4.5 ± 0.20

0.1 MAX 10.1 ± 0.20

9.1 ± 0.20

Ø1.5 ± 0.1/-0

Ramp up = 2–10°C/sec   •  Peak reflow temperature: 245°C (package surface temperature)
  •  Time of temperature higher than 183°C for 120–180 seconds
  •  One time soldering reflow is recommended 

230°C, 10–30 s

Time (Minute)

0

300

250

200

150

100

50

0
0.5 1 1.5 2 2.5 3 3.5 4 4.5

Te
m

p
er

at
u

re
 (

°C
)

Time above 183°C, 120–180 sec

245°C peak



 

LIFE SUPPORT POLICY 

 

FAIRCHILD’S PRODUCTS ARE NOT AUTHORIZED FOR USE AS CRITICAL COMPONENTS IN LIFE SUPPORT DEVICES 
OR SYSTEMS WITHOUT THE EXPRESS WRITTEN APPROVAL OF THE PRESIDENT OF FAIRCHILD SEMICONDUCTOR 
CORPORATION.  As used herein:

1. Life support devices or systems are devices or systems
which, (a) are intended for surgical implant into the body, or
(b) support or sustain life, and (c) whose failure to perform
when properly used in accordance with instructions for use
provided in the labeling, can be reasonably expected to
result in a significant injury of the user.

2. A critical component in any component of a life support
device or system whose failure to perform can be
reasonably expected to cause the failure of the life support
device or system, or to affect its safety or effectiveness.

 

DISCLAIMER 

 

FAIRCHILD SEMICONDUCTOR RESERVES THE RIGHT TO MAKE CHANGES WITHOUT FURTHER NOTICE TO 
ANY PRODUCTS HEREIN TO IMPROVE RELIABILITY, FUNCTION OR DESIGN. FAIRCHILD DOES NOT ASSUME 
ANY LIABILITY ARISING OUT OF THE APPLICATION OR USE OF ANY PRODUCT OR CIRCUIT DESCRIBED HEREIN; 
NEITHER DOES IT CONVEY ANY LICENSE UNDER ITS PATENT RIGHTS, NOR THE RIGHTS OF OTHERS.
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®

           

BTA/BTB12 and T12 Series

SNUBBERLESS™, LOGIC LEVEL & STANDARD 12A TRIACS

September 2002 - Ed: 6A

  

MAIN FEATURES:

DESCRIPTION
Available either in through-hole or surface-mount
packages, the BTA/BTB12 and T12 triac series is
suitable for general purpose AC switching. They
can be used as an ON/OFF function in
applications such as static relays, heating
regulation, induction motor starting circuits... or for
phase control operation in light dimmers, motor
speed controllers,...
The snubberless versions (BTA/BTB...W and T12
series) are specially recommended for use on
inductive loads, thanks to their high commutation
performances. Logic level versions are designed
to interface directly with low power drivers such as
microcontrollers. By using an internal ceramic
pad, the BTA series provides voltage insulated tab
(rated at 2500V RMS) complying with UL
standards (File ref.: E81734)

Symbol Value Unit

IT(RMS) 12 A

VDRM/VRRM 600 and 800 V

IGT (Q1) 5 to 50 mA

ABSOLUTE MAXIMUM RATINGS

Symbol Parameter Value Unit

IT(RMS) RMS on-state current (full sine wave) D²PAK/TO-220AB Tc = 105°C
12 A

TO-220AB Ins. Tc = 90°C

ITSM Non repetitive surge peak on-state 
current  (full cycle, Tj initial = 25°C)

F = 50 Hz t = 20 ms 120 A

F = 60 Hz t = 16.7 ms 126

I²t I²t Value for fusing tp = 10 ms 78 A²s

dI/dt
Critical rate of rise of on-state current 
IG = 2 x IGT , tr ≤ 100 ns F = 120 Hz Tj = 125°C 50 A/µs

VDSM/VRSM
Non repetitive surge peak off-state 
voltage

tp = 10 ms Tj = 25°C
VDRM/VRRM

+ 100
V

IGM Peak gate current tp = 20 µs Tj = 125°C 4 A

PG(AV) Average gate power dissipation Tj = 125°C 1 W

Tstg
Tj

Storage junction temperature range
Operating junction temperature range

- 40 to + 150
- 40 to + 125 °C

G

A2

A1

G

A2

A2
A1

A2

A2A1

G

D2PAK
(T12-G)

G
A2

A1

TO-220AB Insulated
(BTA12)

TO-220AB
(BTB12)



BTA/BTB12 and T12 Series

2/7

ELECTRICAL CHARACTERISTICS (Tj = 25°C, unless otherwise specified)

■ SNUBBERLESS™ and LOGIC LEVEL (3 Quadrants)

■ STANDARD (4 Quadrants)

STATIC CHARACTERISTICS

Note 1: minimum IGT is guaranted at 5% of IGT max.

Note 2: for both polarities of A2 referenced to A1

Symbol Test Conditions Quadrant T12 BTA/BTB12
Unit

T1235 TW SW CW BW

IGT (1)
VD = 12 V        RL = 30 Ω

I - II - III MAX. 35 5 10 35 50 mA

VGT I - II - III MAX. 1.3 V

VGD VD = VDRM   RL = 3.3 kΩ
Tj = 125°C

I - II - III MIN. 0.2
V

IH (2) IT = 100 mA MAX. 35 10 15 35 50 mA

IL IG = 1.2 IGT I - III MAX. 50 10 25 50 70 mA

II 60 15 30 60 80

dV/dt (2) VD =  67 %VDRM  gate open
Tj = 125°C

MIN. 500 20 40 500 1000 V/µs

(dI/dt)c (2) (dV/dt)c = 0.1 V/µs    Tj = 125°C MIN. - 3.5 6.5 - - A/ms

(dV/dt)c = 10 V/µs     Tj = 125°C - 1 2.9 - -

Without snubber        Tj = 125°C 6.5 - - 6.5 12

Symbol Test Conditions Quadrant BTA/BTB12
Unit

C B

IGT (1)
VD = 12 V       RL = 30 Ω

I - II - III
IV

MAX.
25
50

50
100

mA

VGT ALL MAX. 1.3 V

VGD VD = VDRM   RL = 3.3 kΩ   Tj = 125°C ALL MIN. 0.2 V

IH (2) IT = 500 mA MAX. 25 50 mA

IL IG = 1.2 IGT I - III - IV MAX. 40 50 mA

II 80 100

dV/dt (2) VD =  67 %VDRM  gate open   Tj = 125°C MIN. 200 400 V/µs

(dV/dt)c (2) (dI/dt)c = 5.3 A/ms                  Tj = 125°C MIN. 5 10 V/µs

Symbol Test Conditions Value Unit

VT (2) ITM = 17 A        tp = 380 µs Tj = 25°C MAX. 1.55 V

Vto (2) Threshold voltage Tj = 125°C MAX. 0.85 V

Rd (2) Dynamic resistance Tj = 125°C MAX. 35 mΩ

IDRM

IRRM

VDRM = VRRM Tj = 25°C
MAX.

5 µA

Tj = 125°C 1 mA
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THERMAL RESISTANCES

S = Copper surface under tab

PRODUCT SELECTOR

BTB: non insulated TO-220AB package

ORDERING INFORMATION 

Symbol Parameter Value Unit

Rth(j-c) Junction to case (AC) D²PAK/TO-220AB 1.4 °C/W

TO-220AB Insulated 2.3

Rth(j-a) Junction to ambient S = 1 cm² D²PAK 45 °C/W

TO-220AB
TO-220AB Insulated

60

Part Number
Voltage (xxx)

Sensitivity Type Package
600 V 800 V

BTA/BTB12-xxxB X X 50 mA Standard TO-220AB

BTA/BTB12-xxxBW X X 50 mA Snubberless TO-220AB

BTA/BTB12-xxxC X X 25 mA Standard TO-220AB

BTA/BTB12-xxxCW X X 35 mA Snubberless TO-220AB

BTA/BTB12-xxxSW X X 10 mA Logic level TO-220AB

BTA/BTB12-xxxTW X X 5 mA Logic Level TO-220AB

T1235-xxxG X X 35 mA Snubberless D²PAK

BT   A   12   -     600    BW    (RG)
TRIAC
SERIES

INSULATION:
A: insulated
B: non insulated

CURRENT: 12A

SENSITIVITY & TYPE
B: 50mA STANDARD
BW: 50mA SNUBBERLESS
C: 25mA STANDARD
CW: 35mA SNUBBERLESS
SW: 10mA LOGIC LEVEL
TW: 5mA LOGIC LEVEL

VOLTAGE:
600: 600V
800: 800V

PACKING MODE
Blank: Bulk
RG:Tube

T   12   35    -     600   G      (-TR)
TRIAC
SERIES

SENSITIVITY:
35: 35mA

VOLTAGE:
600: 600V
800: 800V

CURRENT: 12A

PACKAGE:
G: D PAK2

PACKING MODE:
Blank:Tube
-TR:Tape & Reel
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OTHER INFORMATION

Note:   xxx = voltage,  yy = sensitivity,  z = type

Part Number Marking Weight Base
quantity

Packing
mode

BTA/BTB12-xxxyz BTA/BTB12-xxxyz 2.3 g 250 Bulk

BTA/BTB12-xxxyzRG BTA/BTB12-xxxyz 2.3 g 50 Tube

T1235-xxxG T1235xxxG 1.5 g 50 Tube

T1235-xxxG-TR T1235xxxG 1.5 g 1000 Tape & reel

Fig. 1: Maximum power dissipation versus RMS
on-state current (full cycle).

Fig. 2-1: RMS on-state current versus case
temperature (full cycle).

Fig. 2-2: RMS on-state current versus ambient
temperature (printed circuit board FR4, copper
thickness: 35µm),full cycle.

Fig. 3: Relative variation of thermal impedance
versus pulse duration.
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Fig. 4:  On-state characteristics (maximum
values).

Fig. 5: Surge peak on-state current versus
number of cycles.

Fig. 6: Non-repetitive surge peak on-state
current for a sinusoidal pulse with width
tp < 10ms, and corresponding value of I²t.

Fig. 7: Relative variation of gate trigger current,
holding current and latching current versus
junction temperature (typical values).

Fig. 8-1: Relative variation of critical rate of
decrease of main current versus (dV/dt)c (typical
values) (BW/CW/T1235).

Fig. 8-2: Relative variation of critical rate of
decrease of main current versus (dV/dt)c (typical
values) (TW).
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Fig. 9: Relative variation of critical rate of
decrease of main current versus junction
temperature.

Fig. 10: D²PAK Thermal resistance junction to
ambient versus copper surface under tab (printed
circuit board FR4, copper thickness: 35 µm).
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PACKAGE MECHANICAL DATA
D²PAK (Plastic)

REF.

DIMENSIONS

Millimeters Inches

Min. Typ. Max. Min. Typ. Max.

A 4.30 4.60 0.169 0.181

A1 2.49 2.69 0.098 0.106

A2 0.03 0.23 0.001 0.009

B 0.70 0.93 0.027 0.037

B2 1.25 1.40 0.048 0.055

C 0.45 0.60 0.017 0.024

C2 1.21 1.36 0.047 0.054

D 8.95 9.35 0.352 0.368

E 10.00 10.28 0.393 0.405

G 4.88 5.28 0.192 0.208

L 15.00 15.85 0.590 0.624

L2 1.27 1.40 0.050 0.055

L3 1.40 1.75 0.055 0.069

R 0.40 0.016

V2 0° 8° 0° 8°

A

C2

D

R

2.0 MIN.
FLAT ZONE

A2

V2

C

A1

G

L

L3

L2

B

B2

E

FOOTPRINT DIMENSIONS (in millimeters)
D²PAK (Plastic)

8.90
3.70

1.30

5.08

16.90

10.30
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PACKAGE MECHANICAL DATA

TO-220AB / TO-220AB Ins.

REF.

DIMENSIONS

Millimeters Inches

Min. Typ. Max. Min. Typ. Max.

A 15.20 15.90 0.598 0.625

a1 3.75 0.147

a2 13.00 14.00 0.511 0.551

B 10.00 10.40 0.393 0.409

b1 0.61 0.88 0.024 0.034

b2 1.23 1.32 0.048 0.051

C 4.40 4.60 0.173 0.181

c1 0.49 0.70 0.019 0.027

c2 2.40 2.72 0.094 0.107

e 2.40 2.70 0.094 0.106

F 6.20 6.60 0.244 0.259

I 3.75 3.85 0.147 0.151

I4 15.80 16.40 16.80 0.622 0.646 0.661

L 2.65 2.95 0.104 0.116

l2 1.14 1.70 0.044 0.066

l3 1.14 1.70 0.044 0.066

M 2.60 0.102

M

B

l4

C

b2

a2
l2

c2

l3

b1

a1

A

F

L

I

e
c1
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The  Arduino  Uno  is  a  microcontroller  board  based  on  the  ATmega328  (datasheet).  It  has  14  digital 
input/output pins (of which 6 can be used as PWM outputs), 6 analog inputs, a 16 MHz crystal oscillator, a 
USB connection,  a power jack,  an ICSP header,  and a reset  button.  It  contains everything needed to 
support the microcontroller; simply connect it to a computer with a USB cable or power it with a AC-to-DC 
adapter or battery to get started. The Uno differs from all preceding boards in that it does not use the FTDI 
USB-to-serial driver chip. Instead, it features the Atmega8U2 programmed as a USB-to-serial converter.

"Uno" means one in Italian and is named to mark the upcoming release of Arduino 1.0. The Uno and version 
1.0 will be the reference versions of Arduno, moving forward. The Uno is the latest in a series of USB 
Arduino boards, and the reference model for the Arduino platform; for a comparison with previous versions, 
see the index of Arduino boards.

http://arduino.cc/en/Main/Boards
http://www.atmel.com/dyn/resources/prod_documents/doc8161.pdf


EAGLE files: arduino-duemilanove-uno-design.zip Schematic: arduino-uno-schematic.pdf

Microcontroller ATmega328
Operating Voltage 5V
Input Voltage (recommended) 7-12V
Input Voltage (limits) 6-20V
Digital I/O Pins 14 (of which 6 provide PWM output)
Analog Input Pins 6
DC Current per I/O Pin 40 mA
DC Current for 3.3V Pin 50 mA

Flash Memory 32 KB of which 0.5 KB used by 
bootloader

SRAM 2 KB 
EEPROM 1 KB 
Clock Speed 16 MHz



The Arduino Uno can be powered via the USB connection or with an external power supply. The power  
source is selected automatically.

External (non-USB) power can come either from an AC-to-DC adapter (wall-wart) or battery. The adapter 
can be connected by plugging a 2.1mm center-positive plug into the board's power jack. Leads from a 
battery can be inserted in the Gnd and Vin pin headers of the POWER connector.

The board can operate on an external supply of 6 to 20 volts. If supplied with less than 7V, however, the 5V 
pin may supply less than five volts and the board may be unstable. If using more than 12V, the voltage 
regulator may overheat and damage the board.  The recommended range is 7 to 12 volts.

The power pins are as follows: 

• VIN. The input voltage to the Arduino board when it's using an external power source (as opposed to 
5 volts from the USB connection or other regulated power source). You can supply voltage through 
this pin, or, if supplying voltage via the power jack, access it through this pin. 

• 5V. The regulated power supply used to power the microcontroller and other components on the 
board. This can come either from VIN via an on-board regulator, or be supplied by USB or another 
regulated 5V supply. 

• 3V3. A 3.3 volt supply generated by the on-board regulator. Maximum current draw is 50 mA. 
• GND. Ground pins. 

The Atmega328 has 32 KB of flash memory for storing code (of which 0,5 KB is used for the bootloader); It  
has also 2 KB of SRAM and 1 KB of EEPROM (which can be read and written with the EEPROM library).

Each of the 14 digital pins on the Uno can be used as an input or output, using pinMode(), digitalWrite(), and 
digitalRead() functions. They operate at 5 volts. Each pin can provide or receive a maximum of 40 mA and 
has an internal  pull-up resistor  (disconnected by default)  of  20-50 kOhms.  In  addition,  some pins have 
specialized functions: 

• Serial: 0 (RX) and 1 (TX). Used to receive (RX) and transmit (TX) TTL serial data. TThese pins are 
connected to the corresponding pins of the ATmega8U2 USB-to-TTL Serial chip . 

• External Interrupts: 2 and 3. These pins can be configured to trigger an interrupt on a low value, a 
rising or falling edge, or a change in value. See the attachInterrupt() function for details. 

• PWM: 3, 5, 6, 9, 10, and 11. Provide 8-bit PWM output with the analogWrite() function. 
• SPI: 10 (SS), 11 (MOSI), 12 (MISO), 13 (SCK). These pins support SPI communication, which, 

although provided by the underlying hardware, is not currently included in the Arduino language. 

• LED: 13. There is a built-in LED connected to digital pin 13. When the pin is HIGH value, the LED is  
on, when the pin is LOW, it's off. 

http://arduino.cc/en/Reference/AnalogWrite
http://arduino.cc/en/Reference/AttachInterrupt
http://arduino.cc/en/Reference/DigitalRead
http://arduino.cc/en/Reference/DigitalWrite
http://arduino.cc/en/Reference/PinMode
http://www.arduino.cc/en/Reference/EEPROM


The Uno has 6 analog inputs, each of which provide 10 bits of resolution (i.e. 1024 different values). By  
default they measure from ground to 5 volts, though is it possible to change the upper end of their range 
using  the  AREF  pin  and  the  analogReference()  function.  Additionally,  some  pins  have  specialized 
functionality: 

• I2C: 4 (SDA) and 5 (SCL). Support I2C (TWI) communication using the Wire library. 

There are a couple of other pins on the board: 

• AREF. Reference voltage for the analog inputs. Used with analogReference(). 
• Reset. Bring this line LOW to reset  the microcontroller.  Typically  used to add a reset  button to 

shields which block the one on the board. 

See also the mapping between Arduino pins and Atmega328 ports. 

The Arduino Uno has a number of facilities for communicating with a computer, another Arduino, or other 
microcontrollers. The ATmega328 provides UART TTL (5V) serial communication, which is available on 
digital pins 0 (RX) and 1 (TX). An ATmega8U2 on the board channels this serial communication over USB 
and appears as a virtual com port to software on the computer. The '8U2 firmware uses the standard USB 
COM drivers, and no external driver is needed. However, on Windows, an *.inf file is required..

The Arduino software includes a serial monitor which allows simple textual data to be sent to and from the 
Arduino board. The RX and TX LEDs on the board will flash when data is being transmitted via the USB-to-
serial chip and USB connection to the computer (but not for serial communication on pins 0 and 1).

A SoftwareSerial library allows for serial communication on any of the Uno's digital pins. 

The  ATmega328 also support  I2C (TWI) and SPI communication. The Arduino software includes a Wire 
library to simplify use of the  I2C bus; see the  documentation for details. To use the SPI communication, 
please see the ATmega328 datasheet. 

The  Arduino  Uno  can  be  programmed  with  the  Arduino  software  (download).  Select  "Arduino  Uno  w/ 
ATmega328" from the  Tools > Board menu (according to the microcontroller on your board). For details,  
see the reference and tutorials. 

The ATmega328 on the Arduino Uno comes preburned with a bootloader that allows you to upload new code 
to  it  without  the use of  an external  hardware  programmer.  It  communicates  using the original  STK500 
protocol (reference, C header files). 

You can also bypass the bootloader and program the microcontroller through the ICSP (In-Circuit Serial 
Programming) header; see these instructions for details. 

The ATmega8U2 firmware source code is available . The ATmega8U2 is loaded with a DFU bootloader,  
which can be activated by connecting the solder jumper on the back of the board (near the map of Italy) and  
then resetting the 8U2. You can then use Atmel's FLIP software (Windows) or the DFU programmer (Mac 
OS X and Linux) to load a new firmware. Or you can use the ISP header with an external programmer 
(overwriting the DFU bootloader). 

http://dfu-programmer.sourceforge.net/
http://www.atmel.com/dyn/products/tools_card.asp?tool_id=3886
http://dev.arduino.cc/wiki/uno/Hacking/Programmer
http://www.atmel.com/dyn/resources/prod_documents/avr061.zip
http://www.atmel.com/dyn/resources/prod_documents/doc2525.pdf
http://arduino.cc/en/Tutorial/Bootloader
http://arduino.cc/en/Tutorial/HomePage
http://arduino.cc/en/Reference/HomePage
http://arduino.cc/en/Main/Software
http://arduino.cc/en/Reference/Wire
http://www.arduino.cc/en/Reference/SoftwareSerial
http://arduino.cc/en/Hacking/PinMapping168
http://arduino.cc/en/Reference/AnalogReference
http://arduino.cc/en/Reference/Wire
http://arduino.cc/en/Reference/AnalogReference


Rather than requiring a physical press of the reset button before an upload, the Arduino Uno is designed in a  
way that allows it to be reset by software running on a connected computer. One of the hardware flow control  
lines (DTR)  of  the ATmega8U2 is  connected to  the reset  line of  the ATmega328 via  a  100 nanofarad 
capacitor. When this line is asserted (taken low), the reset line drops long enough to reset the chip. The 
Arduino software uses this capability to allow you to upload code by simply pressing the upload button in the  
Arduino environment. This means that the bootloader can have a shorter timeout, as the lowering of DTR 
can be well-coordinated with the start of the upload. 

This setup has other implications. When the Uno is connected to either a computer running Mac OS X or 
Linux, it resets each time a connection is made to it from software (via USB). For the following half-second or 
so, the bootloader is running on the  Uno. While it is programmed to ignore malformed data (i.e. anything 
besides  an  upload  of  new code),  it  will  intercept  the  first  few bytes  of  data  sent  to  the board  after  a  
connection is opened. If a sketch running on the board receives one-time configuration or other data when it  
first  starts,  make sure  that  the  software  with  which  it  communicates  waits  a  second after  opening the  
connection and before sending this data. 

The Uno contains a trace that can be cut to disable the auto-reset. The pads on either side of the trace can  
be soldered together to re-enable it. It's labeled "RESET-EN". You may also be able to disable the auto-reset 
by connecting a 110 ohm resistor from 5V to the reset line; see this forum thread for details. 

The  Arduino  Uno has  a  resettable  polyfuse  that  protects  your  computer's  USB ports  from shorts  and 
overcurrent. Although most computers provide their own internal protection, the fuse provides an extra layer 
of protection. If more than 500 mA is applied to the USB port, the fuse will automatically break the connection 
until the short or overload is removed. 

The maximum length and width of the Uno PCB are 2.7 and 2.1 inches respectively, with the USB connector 
and power jack extending beyond the former dimension. Three screw holes allow the board to be attached to 
a surface or case. Note that the distance between digital pins 7 and 8 is 160 mil (0.16"), not an even multiple 
of the 100 mil spacing of the other pins. 

http://www.arduino.cc/cgi-bin/yabb2/YaBB.pl?num=1213719666/all


Arduino can sense the environment by receiving input from a variety of sensors and can affect its 
surroundings by controlling lights, motors, and other actuators. The microcontroller on the board is 
programmed  using  the  Arduino  programming  language (based  on  Wiring)  and  the  Arduino 
development environment (based on Processing). Arduino projects can be stand-alone or they can 
communicate with software on running on a computer (e.g. Flash, Processing, MaxMSP).

Arduino is a cross-platoform program. You’ll have to follow different instructions for your personal 
OS. Check on the Arduino site for the latest instructions.  http://arduino.cc/en/Guide/HomePage

Once you have downloaded/unzipped the arduino IDE, you can Plug the Arduino to your PC via USB cable.

Now you’re actually ready to “burn” your 
first  program on the arduino board. To 
select “blink led”, the physical translation 
of  the  well  known  programming  “hello 
world”, select

File>Sketchbook>
Arduino-0017>Examples>
Digital>Blink

Once you have your skecth you’ll 
see something very close to the 
screenshot on the right. 

In Tools>Board select

Now you have to go to
Tools>SerialPort 
and select the right serial port, the 
one arduino is attached to.

http://arduino.cc/en/Guide/HomePage
http://www.processing.org/
http://wiring.org.co/
http://arduino.cc/en/Reference/HomePage




1.      Warranties 

1.1     The producer warrants that its products will conform to the Specifications. This warranty lasts for one (1) years from the date of the sale. The 
producer shall not be liable for any defects that are caused by neglect, misuse or mistreatment by the Customer, including improper installation or testing,  
or for any products that have been altered or modified in any way by a Customer. Moreover, The producer shall not be liable for any defects that result from 
Customer's design, specifications or instructions for such products. Testing and other quality control techniques are used to the extent the producer deems 
necessary.

1.2     If any  products fail to conform to the warranty set forth above, the producer's sole liability shall be to replace such products. The producer's liability 
shall be limited to products that are determined by the producer not to conform to such warranty. If the producer elects to replace such products, the 
producer shall have a reasonable time to replacements. Replaced products shall be warranted for a new full warranty period.

1.3     EXCEPT AS SET FORTH ABOVE, PRODUCTS ARE PROVIDED "AS IS" AND "WITH ALL FAULTS." THE PRODUCER DISCLAIMS ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, REGARDING PRODUCTS, INCLUDING BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE

1.4     Customer agrees that prior to using any systems that include the producer products, Customer will test such systems and the functionality of the 
products as used in such systems. The producer may provide technical, applications or design advice, quality characterization, reliability data or other 
services. Customer acknowledges and agrees that providing these services shall not expand or otherwise alter the producer's warranties, as set forth 
above, and no additional obligations or liabilities shall arise from the producer providing such services.

1.5     The Arduino products are not authorized for use in safety-critical applications where a failure of the product would reasonably be expected to cause 
severe personal injury or death. Safety-Critical Applications include, without limitation, life support devices and systems, equipment or systems for the 
operation of nuclear facilities and weapons systems. Arduino products are neither designed nor intended for use in military or aerospace applications or 
environments and for automotive applications or environment. Customer acknowledges and agrees that any such use of Arduino products which  is solely 
at the Customer's risk, and that Customer is solely responsible for compliance with all legal and regulatory requirements in connection with such use.

1.6 Customer acknowledges and agrees that it is solely responsible for compliance with all legal, regulatory and safety-related requirements concerning its 
products and any use of Arduino products in Customer's applications, notwithstanding any applications-related information or support that may be 
provided by the producer.

2.       Indemnification

The Customer acknowledges and agrees to defend, indemnify and hold harmless the producer from and against any and all third-party losses, damages,  
liabilities and expenses it incurs to the extent directly caused by: (i) an actual breach by a Customer of the representation and warranties made under this 
terms and conditions or (ii) the gross negligence or willful misconduct by the Customer.

3.        Consequential Damages Waiver

In no event the producer shall be liable to the Customer or any third parties for any special, collateral, indirect, punitive, incidental, consequential or  
exemplary damages in connection with or arising out of the products provided hereunder, regardless of whether the producer has been advised of the 
possibility of such damages. This section will survive the termination of the warranty period.

4.      Changes to specifications

The producer  may make changes to specifications and product descriptions at any time, without notice. The Customer must not rely on the absence or 
characteristics of any features or instructions marked "reserved" or "undefined." The producer reserves these for future definition and shall have no 
responsibility whatsoever for conflicts or incompatibilities arising from future changes to them. The product information on the Web Site or Materials is 
subject to change without notice. Do not finalize a design with this information.

The producer of Arduino  has joined the Impatto Zero® 
policy of LifeGate.it. For each Arduino board produced is 
created / looked after half  squared Km of Costa Rica’s 
forest’s.
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1. Product’s picture   

 

Figure 1 A Bluetooth module 
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Figure 2. A Bluetooth module size 

 
Figure 3 50 pieces chips in an anti-static blister package. 
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2. Feature 

 Wireless transceiver 

  Sensitivity (Bit error rate) can reach -80dBm.  

  The change range of output’s power:  -4 - +6dBm.  

 Function description (perfect Bluetooth solution) 

 Has an EDR module; and the change range of modulation depth: 2Mbps - 3Mbps. 

 Has a build-in 2.4GHz antenna; user needn’t test antenna. 

 Has the external 8Mbit FLASH 

 Can work at the low voltage (3.1V~4.2V). The current in pairing is in the range of 30～40mA. 

The current in communication is 8mA.  

 Standard HCI Port (UART or USB) 

 USB Protocol: Full Speed USB1.1, Compliant With 2.0 

 This module can be used in the SMD. 

 It’s made through RoHS process. 

 The board PIN is half hole size. 

 Has a 2.4GHz digital wireless transceiver. 

 Bases at CSR BC04 Bluetooth technology.  

 Has the function of adaptive frequency hopping. 

 Small (27mm×13mm×2mm) 

 Peripherals circuit is simple.  

 It’s at the Bluetooth class 2 power level. 

 Storage temperature range: -40 ℃ - 85℃，work temperature range: -25 ℃ - +75℃ 

 Any wave inter Interference: 2.4MHz，the power of emitting: 3 dBm. 

 Bit error rate: 0. Only the signal decays at the transmission link, bit error may be produced. For 

example, when RS232 or TTL is being processed, some signals may decay.  

 

 Low power consumption 

 Has high-performance wireless transceiver system 

 Low Cost 
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 Application fields:  

 Bluetooth Car Handsfree Device 

 Bluetooth GPS 

 Bluetooth PCMCIA , USB Dongle 

 Bluetooth Data Transfer 

 Software 

 CSR 

 

3．PINs description    

 
Figure 3 PIN configuration 

The PINs at this block diagram is as same as the physical one.  
PIN Name PIN # Pad type Description Note 

GND 13 21 22 VSS Ground pot  

1V8 14 VDD 

Integrated  1.8V (+) supply with 

On-chip linear regulator output 

within 1.7-1.9V 

 

VCC 12 3.3V   

AIO0 9 Bi-Directional Programmable input/output line  

AIO1 10 Bi-Directional Programmable input/output line  
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PIO0 23 
Bi-Directional 

RX EN 

Programmable input/output line, 

control output for LNA(if fitted) 
 

PIO1 24 
Bi-Directional 

TX EN 

Programmable input/output line, 

control output for PA(if fitted) 
 

PIO2 25 Bi-Directional Programmable input/output line  

PIO3 26 Bi-Directional Programmable input/output line  

PIO4 27 Bi-Directional Programmable input/output line  

PIO5 28 Bi-Directional Programmable input/output line  

PIO6 29 Bi-Directional Programmable input/output line CLK_REQ 

PIO7 30 Bi-Directional Programmable input/output line CLK_OUT 

PIO8 31 Bi-Directional Programmable input/output line  

PIO9 32 Bi-Directional Programmable input/output line  

PIO10 33 Bi-Directional Programmable input/output line  

PIO11 34 Bi-Directional Programmable input/output line  

RESETB 11 

CMOS Input with 

weak intemal 

pull-down 

  

UART_RTS 4 

CMOS output, 

tri-stable with weak 

internal pull-up 

UART request to send, active low  

UART_CTS 3 

CMOS input with 

weak internal 

pull-down 

UART clear to send, active low  

UART_RX 2 

CMOS input with 

weak internal 

pull-down 

UART Data input  

UART_TX 1 

CMOS output, 

Tri-stable with 

weak internal 

pull-up 

UART Data output  

SPI_MOSI 17 

CMOS input with 

weak internal 

pull-down 

Serial peripheral interface data input  

SPI_CSB 16 
CMOS input with 

weak internal 

Chip select for serial peripheral 

interface, active low 
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pull-up 

SPI_CLK 19 

CMOS input with 

weak internal 

pull-down 

Serial peripheral interface clock  

SPI_MISO 18 

CMOS input with 

weak internal 

pull-down 

Serial peripheral interface data 

Output 
 

USB_- 15 Bi-Directional   

USB_+ 20 Bi-Directional   

1.8V 14  1.8V external power supply input 

Default : 

1.8V 

internal powe

r supply.  

PCM_CLK 5 Bi-Directional   

PCM_OUT 6 CMOS output   

PCM_IN 7 CMOS Input   

PCM_SYNC 8 Bi-Directional   
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4. The parameters and mode of product 

 
If you want more information, please visit www.wavesen.com. 
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5. Block diagram 

 
Figure 5 Block diagram 1 

 
Figure 5 Block diagram 2 
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HC-04/06 master device has a function of remembering the last paired slave device. As a master 

device, it will search the last paired salve device until the connection is built. But if the WAKEUP 

bottom is pressed, HC-04/06 will lose the memory and research the new slave device.  

 

6. Debugging device 

6.1 Device 

PC, hardware, 3G，3G Frequency Counter (SP3386), 3.15V DC power supply, Shielding，Bluetooth 

Test box. 

6.2 Software       
 

7. Characteristic of test 

Test Condition 25℃ RH 65%  

            Min Typ  Max Unit 
1. Carrier Freq.  ( ISM Band )      2.4    2.4835 MHz 

2.  RF O/P Power         -6    2  4  dBm 

3. Step size of Power control      2    8     dB 

4.  Freq. Offset ( Typical Carrier freq.)    -75    75  KHz 

5. Carrier Freq. drift ( Hopping on, drift rate/50uS )  -20    20  KHz 

 1 slot packet          -25    25  KHz 

 3 slot packet         -40    -40  KHz 

6.  Average Freq. Deviations ( Hopping off, modulation ) 140    175  KHz 

 Freq. Deviation        115      KHz 

Ratio of Freq. Deviation            0.8 

7 . Receive Sensitivity @< 0.1% BER( Bit error rate   )-83      dBm 
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8. Test diagram 

 

UUT Interface 
circuit

3GHz Ferq. 
Counter

RF  O/P

SPI

LPT1

COM 1

RS232

CH C

Fig 1. Programming and Freq. Alignment

Shielding Box

Computer

 
 

 

UUT

Bluetooth test 
set

Computer

Fig 2 RF parameter Test Procedure

RF Port

RF I/P

GPIB

COM 1

RS232

SPI

LP1

Shielding Box
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9．AT command set 

The way to the AT command mode: supply power to the module, it will enter to the AT mode if it 

needn’t pair. The interval of command is about 1 second.  

Default parameter: Baud rate:9600N81, ID: linvor, Password:1234 

1. Test communication 

Send: AT (please send it every second) 

Back: OK 

 

2. Reset the Bluetooth serial baud rate  

Send: AT+BAUD1 

Back: OK1200 

Send: AT+BAUD2 

Back: OK2400 

…… 

1---------1200 

2---------2400 

3---------4800 

4---------9600 (Default) 

5---------19200 

6---------38400 

7---------57600 

8---------115200 

9---------230400 

A---------460800 

B---------921600 

C---------1382400 

PC can’t support the baud rate lager than 115200. The solution is: make the MCU have higher baud 

rate (lager than 115200) through programming, and reset the baud rate to low level through the AT 

command.  

The baud rate reset by the AT command can be kept for the next time even though the power is cut 

off. 

 

3. Reset the Bluetooth name 

Send: AT+NAMEname 

Back: OKname 
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Parameter name: Name needed to be set (20 characters limited) 

Example: 

Send: AT+NAMEbill_gates 

Back: OKname 

    Now, the Bluetooth name is reset to be “bill_gates” 

The parameter can be kept even though the power is cut off. User can see the new Bluetooth name 

in PDA refresh service. (Note: The name is limited in 20 characters.) 

 

4. change the Bluetooth pair password 

Send: AT+PINxxxx 

Back:OKsetpin 

Parameter xxxx: The pair password needed to be set, is a 4-bits number. This command can be used 

in the master and slave module. At some occasions, the master module may be asked to enter the 

password when the master module tries to connect the slave module (adapter or cell-phone). Only if the 

password is entered, the successful connection can be built. At the other occasions, the pair can be finish 

automatically if the master module can search the proper slave module and the password is correct. 

Besides the paired slave module, the master can connect the other devices who have slave module, such 

as Bluetooth digital camera, Bluetooth GPS, Bluetooth serial printer etc. 

Example: 

Send: AT+PIN8888 

Back: OKsetpin 

Then the password is changed to be 8888, while the default is 1234. 

This parameter can be kept even though the power is cut off. 

 

5. No parity check ( The version, higher than V1.5, can use this command )  

Send: AT+PN (This is the default value) 

Back: OK NONE   

 

6. Set odd parity check ( The version, higher than V1.5, can use this command )  

Send: AT+PO 

Back: OK ODD  

  

7. Set even parity check( The version, higher than V1.5, can use this command )  

Send: AT+PE 

Back: OK EVEN 
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8. Get the AT version 

Send: AT+VERSION 

Back: LinvorV1.n 
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